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1 Srodowisko WDM do tworzenia aplikacji réwnolegtych i
rozproszonych na platformie MS Windows

Zamystem przy projektowaniu tego systemu byto stworzenie wirtualnej maszyny
umozliwiajgcej prowadzenie obliczen réwnolegtych oraz symulacji przy wykorzystaniu wielu
procesorow. Prowadzenie obliczen réwnolegtych na takiej maszynie jest mozliwe poprzez
dekompozycje podstawowego zadania na szereg mniej ztozonych zadan obliczeniowych.
Umiejetne przyporzadkowanie zadan (najbardziej czasochtonne jednostkom o najwiekszej
mocy obliczeniowej) pozwala na efektywne wykorzystanie zasobOw systemu
komputerowego jakim jest sie¢ stacji roboczych.

Biblioteka Windows Distributed Machine (WDM) nawigzuje w pewnym stopniu do
systemow PVM, MPI oraz systemu symulacyjnego CSA&S. Mechanizmy tworzenia i
niszczenia procesdéw sg podobne do PVM i CSA&S, komunikacja przypomina te z MPI.
Zasadnicza réznica miedzy systemami WDM i CSA&S polega na tym, ze w systemie
CSA&S obliczenia odbywaty sie przy wykorzystaniu jednego komputera, a WDM pozwala
uruchamiaé procesy na wielu komputerach pracujgcych w sieci. Ponadto WDM nie byt
projektowany jako system do symulacji ztozonych systemdw, cho¢ oczywiscie moze by¢ do
tego celu wykorzystywany. Biblioteka ma zapewni¢ mozliwo$¢ przeprowadzania symulaciji
badz obliczen na komputerach klasy PC pracujgcych na platformie Windows 95, Windows
98, Windows NT i Windows 2000. Uzytkownik, czyli programista rozproszonych aplikacji
numerycznych nie powinien przy tym wgtebia¢ sie w szczegdty dotyczgce komunikaciji.
Detale implementacyjne zaszyte sa w procedurach biblioteki.

1.1 Budowa systemu

W systemie mozna wyrdznié cztery gtdbwne moduty oraz jednostki obliczeniowe:

Remote Execute Service (rexecsrv.exe, rexec95, rexeccmd.exe)

Zestaw programéw (demondw) pozwalajacych zdalnie uruchamia¢ nasze procesy na
odlegtych maszynach. Aktywacja demonéw odbywa sie recznie lub automatycznie jak to ma
miejsce w przypadku serwiséw Windows NT 4.0 i Windows 2000.

Windows Distributed Machine Console (WDMConsole - wdmcon.exe)

Program stuzacy do definiowania projektu. Graficzny interfejs do komunikacji z jednostkami i
jadrem systemu. Program pozwala programiscie nadzorowaé obliczenia lub symulacje.
Modut realizuje nastepujgce funkcje:
e edycja struktury logicznej - przyporzadkowanie procesédw komputerom przez
skojarzenie identyfikatora procesu i adresu IP komputera,

e zdale uruchomienie programéw jednostek,
e zdalne usuniecie programoéw jednostek,
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e wizualizacja stanu jednostek w trakcie obliczen w postaci ikon,
e podgladanie wynikéw posrednich (ekrandw jednostek),

e przekazywanie znakéw wprowadzanych z klawiatury do programéw jednostek
pracujgcych na innym komputerze

Windows Distributed Machine Queue Server (WDMQS)
Jednostka centralna przechowujgca i buforujgca pakiety oraz informacje o aktualnym stanie
jednostek. Jej zadaniem jest:

e kolejkowanie przesytanych pakietéw miedzy jednostkami

e przesylanie powiadomien o zmianie stanu jednostki do WDMConsole

e kierowanie zlecen wydanych przez WDMConsole (run, pause, stop, bye) do
jednostki

e przechowywanie zawartosci ekranoéw jednostek

Biblioteka ulib.lib (ulib.h)

Biblioteka napisana i skompilowana w Microsoft Visual C++ zawierajgca funkcje do
komunikacji, synchronizacji i zdalnego uruchamiania proceséw. Przy pomocy zestawu
procedur mozliwe jest:

e zdalne uruchamianie proces6w — programista bedzie mogt uruchamiaé swoje
procesy na wybranych komputerach, korzystajac z pracujacych tam serwiséw
Remote Execute Service,

o identyfikacja jednostki — nawigzanie fgcznosci, rejestracja, alokacja buforow,
przydzielenie identyfikatora,

e wysylanie i odbieranie komunikatdw — przestanie wiadomosci (dowolnego ciagu
bajtéw) do innej jednostki dziatajgcej w systemie WDM,

e bariera — implementacja podstawowego mechanizmu synchronizacji proceséw.

1.1.1 Remote Execute Service i Rexec95

System operacyjny Windows nie udostepnia mechanizmu, ktéry pozwala na zdalne
uruchamianie programoéw jak to ma miejsce w UNIX'ie (rexec'). System realizuje to zadanie
poprzez serwisy (demony), ktére muszag zostaé uruchomione na kazdym komputerze, ktéry
udostepnia swoje zasoby i pozwala na zdalne uruchamianie programéw. System i funkcje
biblioteczne komunikujg sie z serwisami i zlecajg uruchomienie innego programu. W
zaleznoSci od systemu operacyjnego zainstalowanego na komputerze, mamy do wyboru
dwie aplikacje realizujgce zadanie demona.

rexec95.exe — Windows 95, Windows 98, Windows NT 4.0, Windows 2000.
rexecsrv.exe — Windows NT 4.0, Windows 2000

! rexec - stuzy w systemie UNIX do uruchamiania programéw na zdalnym komputerze, gdzie zostaf uprzednio uruchomiony
demon rexecd
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rexec95.exe

Program rexec95 to zwykta aplikacja uruchamiana przez
uzytkownika. Po uruchomieniu programu w prawym dolnym rogu
pojawia sie ikona informujgca uzytkownika o tym, ze program jest
: aktywny. Zaznaczajac ikone i przyciskajac prawy klawisz myszy
o Service [1339] 4 , A .
2] 75w Mmozemy zako_nczyc_: pracg programu I_ub gktywowac jego okno
(tzn. na ekranie pojawi sie okienko aplikacji rexec95.exe). Mamy
wtedy dostep do menu programu i mozemy przejrze¢ generowane w trakcie pracy
komunikaty. Przeglgdajac wiadomosci dowiemy sie kto, kiedy i co uruchamia na naszym
komputerze. Komunikaty generowane przez aplikacje sg rowniez pomocne w lokalizowaniu
ewentualnych probleméw w trakcie pracy systemu. Programy uruchamiane przez rexec95
pracujg w kontekscie zalogowanego uzytkownika. Zasadniczg wada takiego rozwigzania jest
brak bezpieczenstwa i konieczno$¢ logowania i uruchomienia aplikacji w celu udostepnienia
swojego komputera innym uzytkownikom. Domysinie rexec95 wykorzystuje do komunikacji
port 1999. Jezeli chcemy, aby rexec95 pracowat na innym porcie to podajemy go jako
argument wywotania programu.

Fexe
5

rexecsrv.exe

Z mysla o Windows NT oraz Windows 2000 zostat napisany serwis , Remote
Execute Service”. W skfad programu wchodzg rexecsrv.exe i rexecsrv.dll. Serwis mozna
skonfigurowac tak, aby startowat automatycznie po uruchomieniu systemu. Kolejna zaleta to
mozliwos¢ zdefiniowania konta, na ktérym ma pracowac¢ serwis (Rys. 1-1). Wszystkie
programy, ktére zostang zdalnie uruchomione na naszym komputerze bedg miaty takie
prawa do systemu i do sieci jak konto przypisane serwisowi. Podczas wyboru konta nalezy
pamieta¢ o tym, ze tylko konto systemowe (System Account) ma mozliwo$¢ uruchomienia
programu tak, aby jego wyniki pojawity sie na ekranie (w przypadku, gdy kto$ jest
zalogowany). Jednak konto systemowe nie ma praw do sieci. To znaczy, ze przed
uruchomieniem programu nalezy go skopiowac¢ na dysk lokalny tak aby serwis nie musiat
odwotywac sie do zasobdw udostepnianych w sieci. Jednoczes$nie tak uruchomiony program
ma nieograniczony dostep do naszego systemu. Dedykowane konto jest wiec rozwigzaniem
bezpieczniejszym.

. Service Femate Execute Service
~Startup T
Service Statug Startup Close a.r e . 0k I
lc Hutomatic:
Metwork DDE Manual :l LI
Metwork DDE DSDM Manual Start T~ Manual Cancel |
Metwark Monitor Agent anual " Disabled Hel I
MNT LM Security Support Provider Manual Stop e
Plug and Flay Automal!c [ ~Log On As:
Protected Storage Automatic  Systemd 3
Remote Access Autodial Manager Disabled Coriine apsiem Accoun
Remote Access Connection Manager tdanual — I Allow Service to Interact with Desktop
Remob Manual Shanty
Remos Automalic e % This Account: Iguesl J
Hi Profiles. [
Startup Parameters: = :
LConfirm
&I Password:

Rys. 1-1 Konfiguracja serwisu Remote Execute Service
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Podczas pracy serwis generuje informacje o wykonywanych operacjach, ktére
przechowywane sg w sg w Dzienniku Systemu (EventLogu) i mozna je przejrze¢ w dowolnej
chwili. Na Rys. 1-2 widzimy, ze 99-07-12 o godzinie 20:44 Remote Execute Service
uruchomit na naszym komputerze program \\bobmobile\units\async.exe na zyczenie
uzytkownika pracujagcego w sieci pod adresem 100.100.100.111. W EventLogu mozemy
takze znalez¢ wszelkie informacje o btedach, ktére wystapity podczas pracy serwisu.

{Event ¥iewer - Application Log on \ABOBMOBILE

Log View Options Help

Date |Source ‘Category |Event |User |Compuler
(099-07-12 FemoteExecuteSerMone 1 [RI BOBMOBILE
@ 99-07-12 RemoteExecuteSer None 1 [NgA BOBMOEBILE

FermoteEx MNone BOBMOBILE

AT i e —
E t Detail
990712 RemaoteExecuteSer Nor pen e [x]
990712 54239 PM RemoteExecuteSer Mot 5 i 5
@99-07-12  5.41.28 PM RemnieExecuieSerNor  goe  lle e reeuteton
@99-07-12  8:41:28 PM RemateExecuteSer Mor u'me' e T“”?E' He“w El HECLIEREMVICE
@09-07-12 83919 PM FemoteExecuteSer Mot ESE’ = — c”l’e : N"”’“’a'm
990712 §:21:02 PM Hibemation Moy P aledon: Hone
990712 8:20:09 PM RemoteExecuteSer BNor Description;
Q890712 §20:07 PM FemoteExecuteSer Mot [Execution \hbebmobilsuritshasync. exe 100.100.100.111 2001 A5YNC = |
©99-07-12  7:44:25 PM FemoteExecuteSer Mor |ALFA for 100.100.100.111:1032 Success
99-0712 70231 PM RemoteExecuteSer Nor
©99-07-12 7023 PM FemoteExecuteSer Mot
@99-07-12 60221 PM RemoteExecuteSer Nor
€99-0712  E:071:46 PM RemoteExecuteSer Mok
€099-07-12  6:01:46 PM FemoteExecuteSer Mot
[7]
Dater f® Bytes € Wonds
=
il _'l_I

Clase I

Ereviousl Newt | Help |

Rys. 1-2 EventLog - komunikaty z Remote Execute Service

Przyktadowy scenariusz moze wygladaé nastepujgco: Program jednostki (u.exe)
znajduje sie fizycznie na naszym komputerze ALFA. Chcemy go uruchomié¢ na komputerze
BETA, gdzie jest zainstalowany serwis pracujgcy na koncie GUEST. W pierwszej kolejnosci
musimy stworzy¢ zasob np. “pub” na komputerze ALFA i nada¢ uprawnienia uzytkownikowi
komputera BETA (BETA\guest) do naszego zasobu “pub”. Nastepnie umieszczamy tam kod
programu jednostki (u.exe). W takim przypadku jako argument programu rexec mozemy
podaé nazwe unc? \ALFA\pub\u.exe.

Oprécz mozliwosci zdalnego uruchamiania programoéw serwisy pozwalajg takze na
ich zabicie. Serwis uruchamia program za pomocg funkcji APl CreateProcess() i zwraca

klientowi identyfikator stworzonego procesu. Klient moze pdzniej wykorzysta¢ ten
identyfikator do zabicia procesu. Proces jest zabijany przy uzyciu funkgcji
TerminateProcess().
Argumenty funkcji CreateProcess i TerminateProcess:
BOOL CreateProcess (

LPCTSTR lpApplicationName, // name of executable module

LPTSTR lpCommandLine, // command line string

LPSECURITY ATTRIBUTES lpProcessAttributes, // process security attributes

LPSECURITY ATTRIBUTES lpThreadAttributes, // thread security attributes

BOOL bInheritHandles,

// handle inheritance flag

2 UNC Universal Naming Convention - konwencja nazewnictwa komputeréw i zasobow przyjeta w sieciach Microsoft Network

\\<server name>\<share point name>
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DWORD dwCreationFlags, // creation flags

LPVOID lpEnvironment, // pointer to new environment block

LPCTSTR lpCurrentDirectory, // pointer to current directory name

LPSTARTUPINFO lpStartupInfo, // pointer to STARTUPINFO

LPPROCESS_INFORMATION lpProcessInformation // pointer to PROCESS_INFORMATION
)i
BOOL TerminateProcess (

HANDLE hProcess, // handle to the process

UINT uExitCode // exit code for the process
)i

Procedury do komunikacji z serwisami (wdm_rexec() i wdm_Kkill()) znalazty sie

rébwniez w bibliotece WDM. Uzytkownik moze je wykorzystaé do automatycznego
uruchamiania programow jednostek obliczeniowych.

int wdm _kill( char *host, WORD port,

DWORD PID,

char *username, char *password) ;
int wdm_ rexec( char *host, WORD port,

char *cmdline,

char *username, char *password) ;

1.1.2 Komunikacja miedzy procesami obliczeniowymi i modutami systemu

Komunikacja miedzy modutami odbywa sie poprzez przesytanie komunikatow.
Warstwa transportowa oparta na TCP/IP, pozwala uruchamiaé moduly i jednostki
obliczeniowe na dowolnym komputerze pracujgcym w Internecie. TCP zapewnia
niezawodno$é przesytania pakietdw miedzy komponentami systemu. Sposéb komunikacji
miedzy elementami systemu przedstawia Rys. 1-3

WDMQS _ava'e* WDM Console

8 I
C2

C3
P1 P2 P3

C1

REXEC95
lub
REXECSRV

REXEC95
lub
REXECSRV

Rys. 1-3 Komunikacja miedzy jednostkami
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W pierwszej kolejnosci nalezy uruchomi¢ WDMQS i WDM Console.

1. WDMConsole rejestruje projekt w WDMQS (Windows Distributed )
Machine Queue Server). (=]

2. WDMConsole komunikuje sie z rexecsrv lub rexec95 na komputerze
C3 i przekazuje informacje o jednostce, ktéra ma zostaé uruchomiona
na danym komputerze. Serwis rexec uruchamia program jednostki P3
i przekazuje mu informacje na temat WDMQS (ip, port) oraz
informacje o projekcie (project name, unit name).

3. Jednostka P3 rejestruje sie w WDMQS. Podajac project name, unit
name otrzymuje UID (Unit ID)

4. WDMQS wysyta informacje do WDMConsole potwierdzajac b
rejestracje jednostki P3 w systemie. Eljl P3

5. WDMConsole komunikuje sie z rexecsrv lub rexec95 na komputerze
C1 i przekazuje informacje o jednostce, ktéra ma zostaé¢ uruchomiona
na danym komputerze. Serwis rexec uruchamia program jednostki P1
i przekazuje mu informacje na temat WDMQS (ip, port) oraz
informacje o projekcie(project name, unit name).

6. Jednostka P1 rejestruje sie w WDMQS. Podajgc project name, unit
name otrzymuje UID (Unit ID).

7. WDMQS wysyla informacje do WDMConsole potwierdzajagc  Sp)
rejestracje jednostki P1. LTI

8. Jednostka P2 zostaje recznie uruchomiona na komputerze C2.
Informacje na temat WDMQS (ip, port) oraz informacje o projekcie
(project name, unit name) sg podane jako parametry wywotania
programu. Jednostka rejestruje sie w WDMQS. . Podajac projekt
name, unit name otrzymuje UID (Unit ID).

9. WDMQS wysyla informacje do WDMConsole potwierdzajagc  Sp)
rejestracje jednostki P2. LT P2

W trakcie obliczen komunikacja miedzy jednostkami odbywa sie rowniez za
posrednictwem jadra WDMQS. Jezeli jednostka P1 ma wysta¢ komunikat do jednostki P3
wykonywane sg nastepujace kroki:

1. P1 wywotuje funkcje wdm_send(P3...)

2. Pakiet zawierajgcy nagtéwek oraz tres¢ komunikatu dociera do WDMQS
3. WDMQS umieszcza pakiet w buforze przypisanym jednostce P3
4

. Kiedy jednostka P3 wywota funkcje wdm_recv(P1...) otrzyma od WDMQS pakiet
wystany przez jednostke P1

Stosujgc terminologie z MPI wdm_send() przesyta komunikat w sposéb asynchroniczny,
nieblokujacy, a wdm_recv() asynchronicznie, blokujaco.

Uwaga: Nalezy pamietac o tym, ze WDMQS kolejkuje nadchodzgce pakiety. Jezeli
Jjednostka wywofa funkcje wdm_recv_any() dostanie pakiet, ktory jest pierwszy na liscie.
Jezeli jednostka wywota funkcje wdm_recv(xUID,...) otrzyma pierwszy z pakietéw jakie
nadeszty od jednostki xUID. Wywotanie recv moze byc blokujgce lub nie. Jezeli w buforze
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Jednostki znajdujg sie pakiety kontrolne (stop, pause wystane na polecenie WDMConsole) to
zostang one przekazane w pierwszej kolejnosci, niezaleznie od Zgdania jednostki.

1.1.3 Program WDMQS

Mozna powiedzie¢, ze WDMQS (Windows Distributed Machine Queue Server) jest
sercem systemu. Program moze pracowac jako zwykta aplikacja lub jako serwis NT. Tu sg
kolejkowane wszystkie pakiety. Jadro WDMQS odpowiada takze za alokacje buforéw
jednostek. Do komunikacji z jednostkami WDMQS rezerwuje domys$inie port 2001. Mozna to
zmieni¢ podajgc inny numer portu jako parametr wywotania programu. WDMQS
przechowuje wszystkie informacje o jednostkach (aktualny stan, zawarto$¢ ekranu,
kolejkowane pakiety). W chwili pierwszego potgczenia WDMConsole z WDMQS odbywa sie
rejestracja projektu. Podczas rejestracji WDMConsole przekazuje wszystkie dane o
jednostkach, WDMQS alokuje bufory i inicjuje zmienne dotyczace projektu. W trakcie pracy
WDMQS gromadzi dane naptywajace z jednostek. Takie rozwigzanie pozwala na odtgczenie
WDMConsole i ponowne potgczenie z WDMQS np. z innego komputera. Jezeli
WDMConsole potaczy sie powtdrnie zostanie on powiadomiony, Zze projekt jest juz
zatadowany i aktywny. Wtedy WDMQS prze$le aktualne dane o stanie jednostek do
WDMConsole. Mozliwe jest uruchomienie kilku instancji WDMConsole na roéznych
komputerach w tej samej chwili. Wszystkie bedg jednoczesnie pokazywaé stan jednostek,
ekrany lub przekazywac klawisze. Dziatanie WDMQS jest oparte na opisanej wczes$niej
funkcji select() z biblioteki gniazdek. Program prowadzi rejestr aktywnych potgczen z
jednostkami i konsolami. W trakcie pracy czeka blokujgco az na jednym z obserwowanych
gniazdek pojawig sie dane. Moze to by¢ pakiet wystany przez jedng jednostke do drugiej,
komunikaty sterujgce z konsoli lub nowe informacje o0 zmianie zawartosci ekranu jednostki.
W nagtéwku kazdego komunikatu znajduje sie jego identyfikator. W sumie rozréznia sie
okoto 50 réznych wiadomosci. Po odebraniu komunikatu WDMQS podejmuje wtasciwg
akcje. Komunikaty obstugiwane sg sekwencyjnie.

1.1.4 Konsola operatora - WDMConsole

Z tym modutem bedziemy mieli najwiecej stycznosci podczas pracy z systemem.
Program stuzy do zdefiniowania jednostek (nazwa, ID, host, linia polecehh (command line))
oraz zdalnego uruchomienia jednostek. W trakcie obliczern na ekranie konsoli mozemy
obserwowaé dynamicznie zmieniajacy sie stan jednostek. Kazdy stan jest reprezentowany
przez odpowiednig ikone. Konsola pozwala takze podgladaé wyniki posrednie (ekran)
jednostek oraz interaktywnie wprowadza¢ dane z klawiatury do odlegtych jednostek. Takich
mozliwosci nie dostarczajg wspomniane pakiety PVM i MPI.

Stan jednostki na ekranie WDMConsole

-
El-i" - definiowanie jednostek; projekt nie jest zarejestrowany

=8
- projekt zarejestrowany, jednostka nie uruchomiona

=3
ETI. - do jednostki wystano z konsoli polecenie start

= - | . |
(=] - nieudana préba uruchomienia jednostki, btad komunikacji z serwisem

Remote Execute Service
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- jednostka zostata uruchomiona, ale nie zarejestrowata sie w WDMQS

- jednostka aktywna (wywoftano wdm_UnitRegister)

- do jednostki wystano z konsoli polecenie pause
- jednostka wywotata funkcje wdm_barrier()
- jednostka zawieszona

- do jednostki wystano z konsoli polecenie stop

Ll Ll

- jednostka zakonczyta obliczenia (wdm_UnitStop)

)

- jednostka oczekuje na wprowadzenie danych (wdm_scanf)

gb - jednostka oczekuje blokujgco na dane od innej jednostki (wdm_recv)

1.2 Windows Distributed Machine Library - funkcje biblioteki
ulib.lib

Do komunikacji miedzy jednostkami oraz ich synchronizacji wykorzystujemy funkcje
biblioteczne. Zgodnie z zatozeniami, warstwa sieciowa oparta na TCP/IP jest niewidzialna
dla uzytkownika. Pozwala to programiscie operowaé na wyzszym poziomie i skupi¢ swojg
uwage na rozwigzywanym problemie. Korzystanie z biblioteki eliminuje koniecznosé
kodowania warstwy komunikacyjnej, co niezaprzeczalnie skraca czas pisania aplikacji
rozproszonej. Deklaracje funkcji dostepnych w bibliotece zawarte sg w pliku ulib.h:

// Windows Distributed Machine library ulib.h

#include <windows.h>

lIFunkcje Rejestrujace

WORD wdm UnitRegister (int argc, char **argv);
void wdm UnitUnregister() ;

void wdm UnitStop () ;

/I funkcje komunikacyjne

int wdm recv(int src , char *ptr);

int wdm recv_any (WORD *rsrc, char *ptr);

int wdm _async_recv(int src , char *ptr);

int wdm _async_recv_any(WORD *rsrc, char *ptr);
int wdm send(int dst , char *ptr, int len);

int wdm _send over(int dst , char *ptr, int len);
int wdm broadcast (char *ptr, int len);

int wdm broadcast over(char *ptr, int len);

void wdm barrier (int nUID, char *name, ...);

10
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void wdm barrier all (char *name) ;

/I funkcje wejscia wyjscia
void wdm printf (char *fmt, ...);

void wdm_ scanf (char *s);

/l funkcje dodatkowe
int wdm _kill( char *host, WORD port,
DWORD PID, char *username, char *password) ;
int wdm_rexec( char *host, WORD port,
char *cmdline, char *username, char *password) ;
void wdm_ ParseArgs( int argc, char **argv, char *ip,
WORD *port, char *project, char *name) ;

Funkcje rejestrujgce sg niezbedne do prawidtowego dziatania jednostki. Jednostka
musi sie zarejestrowa¢ w WDMQS i wyrejestrowaé po zakohczeniu obliczen. Wiasciwg
czesS¢ aplikacji piszemy przy wykorzystaniu funkcji komunikacyjnych. Tak naprawde,
wiekszo$§¢ zadan mozemy rozwigzaé przy uzyciu kilku z tych funkcji ( wdm_barrier(),
wdm_recv(), wdm_recv_any(), wdm_send() ). Jednak w szczegdélnych przypadkach, moze
zaistnie¢ potrzeba uzycia funkcji dodatkowych. Rozszerzajg one znacznie mozliwosci
systemu, czynigc go bardziej elastycznym i uniwersalnym.

Doktadny opis procedur bibliotecznych przedstawimy razem z przyktadowymi
programami, ktére beda z nich korzysta¢ w rozdziale 2. Powinno to dopoméc czytelnikowi w
tworzeniu wiasnych aplikacji. W tym rozdziale oméwimy doktadniej to, co jest jedng z
najtrudniejszych rzeczy w obliczeniach rozproszonych, a mianowicie metody synchronizacji
proceséw.

1.2.1 Synchronizacja proceséw w systemie WDM

Do synchronizacji proceséw w systemie WDM stuzy funkcja wdm_barrier.

void wdm_barrier(int nUID, char *name, ...);

gdzie
nUID - okre$la liczbe jednostek potrzebnych do pokonania bariery; 0 oznacza
wszystkie jednostki musza wywotaé wdm_barrier,

name- okre$la nazwe bariery; w danej chwili rézne jednostki mogg byé wstrzymane
(zawieszone) na réznych barierach,

.. - nastepnie nalezy wymieni¢ nUID identyfikatoréw jednostek.

Funkcja wdm_Dbarrier jest blokujgca. W chwili wywotania wdm_barrier jednostka
wysyta informacje do WDMQS. Jezeli nazwa name nie jest jeszcze zarejestrowana jako
bariera, WDMQS rejestruje bariere i od tej chwili Sledzi, ktére jednostki wywotaty funkcje
wdm_barrier z takim parametrem. Kiedy wszystkie jednostki biorgce udziat w barierze
name zgtoszg swojg obecno$é, WDMQS wysyta do nich specjalny komunikat i usuwa
bariere (Rys. 1-4). Wszystkie jednostki opuszczajg funkcje wdm_barrier() i przechodzg do
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wykonania kolejnych linii kodu. W czasie, gdy jednostka jest zablokowana funkcjg
wdm_barrier, nie wykonuje ona zadnych obliczen i czeka na sygnat od WDMQS. Mozna
wtedy z poziomu konsoli wyda¢ polecenie RUN. Sprawi ono, ze WDMQS usunie jednostke z
listy barier i wysle do niej taki sam sygnat jak podczas opuszczania bariery.

> S

——— __ oczekujacych

jednostek

m—Parrier()

P1

rrier()|

P2

ol
wem—bal

barrier
. |

P3 g X
_SI _ >
P4 : £ i
s
P5 ;g _lZ aci
synchronizacja
> -
—Mblokowany
proces aktywny

Rys. 1-4 Dzialanie bariery wdm_barrier

Synchronizacje dwéch proceséw mozna takze uzyskaC poprzez wywotanie
blokujgcej funkcji wdm_recv() i wdm_send(): przez pierwsza z jednostek wdm_send() oraz
wdm_recv() przez drugg. Sytuacje taka przedstawia Rys. 1-5. Proces P1 jako pierwszy
dotart do punktu synchronizacji i wywotat wdm_recv(P2). Pozostanie w tym miejscu do
chwili, gdy proces P2 osiggnie punkt synchronizacji wysytajac pakiet synchronizujacy.
Kolejne instrukcje wdm_send(P2) i wdm_recv(P1) wykonajg sie niemal robwnoczesnie.

P1 P2
P1

wdm_recv(P2) | wdm_recv(P2) M

wdm|_send(P2)

P2

wdm_send(P1) W

wdm_send(P1)

dm_recv(P1)

wdm_send(P2) »  wdm_recv(P1)

proces zablokowany

proces aktywny

Rys. 1-5 Synchronizacja dwéch jednostek (A)

Sytuacje, w ktorej P2 jako pierwszy osiggnie punkt synchronizacji przedstawia Rys.
1-6.
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Pl P2 P1

wdm_send(P1)

wdm_send(P2)

wdm_récv(P2)

wdm_recv(P2) A~

wdm_recv(P1)

wdm_send(P1)

wdm_send(P2) »  wdm_recv(P1)

proces zablokowany

proces aktywny

Rys. 1-6 Synchronizacja dwéch jednostek (B)

Wywotanie funkcji wdm_send() nie jest blokujgce. Program nie czeka na to, az
odbiorca odbierze dane. Synchronizacja zachodzi podczas wywotania funkcji wdm_recv().
Nie ma tez niebezpieczehstwa wystgpienia blokady, kiedy oba procesy wywotujg
jednoczesnie wdm_send(), a nastepnie wdm_recv(). Blokada wystgpi, kiedy oba procesy
wywotajg wdm_recv(), a w ich buforach nie bedzie jeszcze danych. Uzycie funkciji
wdm_barrier() jest jednak najbardziej zalecang i przejrzystg metoda synchronizaciji
procesow.

1.3 Bezpieczenstwo

Poniewaz system pozwala zdalnie uruchamiaé programy na innych komputerach,
niezbedne byto rozwazenie aspektéw bezpieczehstwa takiego dziatania. W przypadku
Windows 95, Windows 98, ktére nie oferujg dodatkowych zabezpieczen, jedynym
zabezpieczeniem jest hasto oraz numer portu na jakim pracuje rexec95. Mozemy uruchomié
kilka instancji rexec95, kazdg z innym numerem portu i hastem. Jednak nie zmienia to faktu,
ze uruchomiona aplikacja ma dostep do wszystkich zasobéw komputera. Jedyne co nam
pozostaje to udostepnia¢ nasze zasoby tylko zaufanym osobom.

Duzo lepsza jest sytuacja w przypadku systemoéw Windows NT i Windows 2000.
Serwis rexecsrv mozemy zainstalowaé na wybranym koncie. Konto moze zostaé tak
skonfigurowane, ze bedzie miato dostep tylko do wybranych zasobéw komputera, np.
katalog c:\tmp. W przypadku udostepniania komputerow z systemami Windows NT i
Windows 2000 przy pomocy rexec95 nalezy pamietaé, ze uruchamiane aplikacje bedg miaty
taki sam dostep do zasobdw jak zalogowany uzytkownik.

Jak wida¢, jedynie Windows NT i Windows 2000 dajg nam mozliwo$¢ bezpiecznego
udostepniania swoich zasobow.

1.4 Implementacja

Wszystkie programy systemu WDM zostaty napisane w jezyku C++. Do kompilacji
zostat wykorzystany Visual C++ 6.0. Srodowisko Microsoft Visual Studio Enterprise
Edition zostatlo wybrane gtéownie z uwagi na jego integracje z systemem operacyjnym.
Mozliwos¢ Sledzenia programéw miata tutaj decydujgce znaczenie. Jednak produkt firmy
Microsoft nie jest tatwy w uzyciu. Jedynym Zzroédtem dokumentacji jest w tym przypadku
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MSDN Library®. Choé¢ dokumentacja jest obszerna nie zawsze jest wystarczajaca.
Nieocenione okazaly sie tez inne bazy danych: TechNet* oraz KnowledgeBase®. Wiasnie w
KnowledgeBase znalazt sie artykut (Article ID: Q168349 BUG: WSAEventSelect( ) Returns WSAEINVAL
if Network Events is 0) dokumentujacy btad w funkcji WSAEventSelect(). Funkcja ta zostata
wykorzystana przy pisaniu serwisu RexecSrv. Wszystkie te pomoce sg kosztowne, ale
niezbedne. Na domiar ztego, wcale nie wyjasniajg wszystkich probleméw zwigzanych z
programowaniem w Windows. Stad tez liczne pozycje ksigzkowe, ktére mozemy znalezé w
bibliografii.

Programy sktadajace sie na pakiet Windows Distributed Machine zawierajg tacznie
okoto 7000 linii kodu. Z uwagi na ich rozmiary nie sg prezentowane ich wydruki. Zaréwno
pliki Zrodtowe, jak i programy wynikowe, zostaty dotgczone do pracy na CD-ROM-ie. Tam
tez znajdujg sie przedstawiane przyktadowe programy i zadania. Wszystkie programy sg 32-
bitowe.

® MSDN Library - Microsoft Developer Network Library. Dokumentacja dostepna na CD lub DVD, niezbedna w pracy z
pakietem Microsoft. Zawiera opis funkcji dostepnych w Visual Basic, Visual C++, Visual FoxPro oraz Visual InterDev. MSDN
zawiera opis architektury systemu Windows, wskazdowki dla programistow, opis udokumentowanych i potwierdzonych btedéw w
systemie.

“ Microsoft TechNet — techniczne informacje dotyczace produktéw Microsoft

® Microsoft Knowledge Base - baza danych z licznymi artykutami poswieconymi Windows NT, Windows 95, Microsoft Office,
SMS, SQL Server, VB, IIS, IE, Encarta, Age of Empires
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2 Instalacjai tworzenie rozproszonych aplikacji przy
pomocy systemu i biblioteki WDM

W rozdziale tym przedstawione beda kolejne kroki jakie nalezy wykonaé, aby
korzystac z systemu i biblioteki Windows Distributed Machine. Przy omawianiu
poszczegoélnych funkcji bibliotecznych bedg przytaczane przyktady, dzieki ktérym tfatwiej
bedzie mozna przesledzi¢ kompletny proces tworzenia aplikacji rozproszonej pracujacej z
systemem WDM.

2.1 Uruchomienie komponentow

Zanim napiszemy i uruchomimy pierwszy program wykorzystujacy biblioteke WDM
musimy zainstalowac niezbedne komponenty systemu:

e WDMQS - instalujemy na jednym z komputeréow

e Serwisy pozwalajgce zdalnie uruchamiaé aplikacje (rexecsrv lub rexec95) -
instalujemy na wszystkich komputerach biorgcych udziat w obliczeniach lub symulaciji

Uwaga: Serwisy nie sg niezbedne do dziatania systemu, gdyz nasze jednostki mozemy
uruchamiac recznie z linii polecen. Jednak ich zainstalowanie uprosci proces uruchamiania.
Kiedy nasz program bedzie gotowy i bedziemy chcieli uruchomic jednostki na réznych
maszynach, instalacje serwisow trzeba przeprowadzi¢ na kazdym komputerze z osobna.
rexecsrv ma tg przewage nad rexec95, Ze pracuje jako serwis NT i moZze wystartowac
nawet wtedy, gdy na komputerze nikt nie jest zalogowany. W potgczeniu z technikg Wake
On Lan® mozemy sobie wyobrazié, ze w dowolnym momencie uruchamiamy odlegte
komputery z zainstalowanym serwisem. Przeprowadzamy nasze obliczenie i nastepnie
mozemy je zdalnie wytgczyc.

2.1.1 Instalacja RexecSrv i Rexec95

RexecSrv (Windows NT, Windows 2000)

RexecSrc sktada sie z dwoch elementéw rexecsrv.exe i rexecsrv.dll. Instalacje
przeprowadzamy po zalogowaniu sie na konto uzytkownika, ktéry ma prawa lokalnego
administratora. Oba pliki nalezy skopiowaé do dowolnego katalogu, jednak najlepiej do
%SystemRoot%\system32. Nastepnie z menu Start->Run uruchamiamy cmd. W kolejnym

® Wake on Lan — zasilanie w komputerach PC (COMPAQ, DELL, HP) jest dzi§ wigczane elektronicznie, a karty sieciowe
potrafig odebra¢ sygnat skierowany do komputera i wigczy¢ zasilanie. W ten sposéb mozemy zdalnie wigczy¢ komputer.
Mechanizm ten jest jeszcze ograniczony tylko do sieci lokalnej. Komputer wybieramy podajagc MAC (Media Access Control)
adres karty sieciowej.
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kroku z linii polecen uruchamiamy rexecsrv.exe —install. W trakcie instalacji program
dokonuje niezbednego wpisu w rejestry. Wpis ten jest konieczny, aby program Event Viewer
poprawnie interpretowat komunikaty od serwisu.

Remote Execute Service dokonuje wpisu w rejestrach w kluczu:
(HKLM\SYSTEM\CurrentControlSet\Services\EventLog\Application\RemoteExecuteService)

Po zainstalowaniu programu nalezy przydzieli¢ mu konto, na ktérym ma pracowac i
wybraé sposéb uruchamiania (manual lub automatic Rys. 2-1).

Service
G x| Service: Femate Execute Service
St
Service Status Startup Close o Ok I
Metwork DDE Marual ;I
Network DDE DSDM Manual Stanl " Manual _Carcel |
Network Moritor Agent Manual € Disabled Hel I
NT LM Security Support Pravider Manual Stop e
Plug and Play Started Automatic B ~Log Onds:
Protected Starage Started Automatic £ Sustem b ]
Remate Access Autodial Manager Disabled Coriie 2pstem Aecoun
Remate Access Connection Manager Manual — I~ &llow Service ta Interact with Desktop
Femote Access Server Marual Starly
Femote Execute Service r Automatic R = This Account: |guest J
Hu Prafiles. Passward:
Startup Parameters:
LConfim
&I Password:

Rys. 2-1 Konfiguracja Remote Execute Service

Serwis rexecsrv mozemy w kazdej chwili usunaé piszac polecenie: rexecsrv —
remove. Program sam usunie wpisy z rejestrow. Jezeli w trakcie pracy napotkamy na
problemy, pomocny bedzie program Event Viewer, za pomocg ktérego mozna obejrzec
komunikaty zapisywane przez serwis.

Rexec95 (Windows 95, Windows 98, Windows NT Windows 2000)

Rexec95 uruchamiamy tak jak kazdag aplikacje w Windows. Podajgc odpowiedni
parametr mozemy zdecydowac jaki port chcemy wykorzystaé. Program rexec95 mozemy
uruchomi¢ kilka razy podajgc zawsze inny numer portu. Jezeli udostepniamy nasz komputer
réznym osobom, kazda z nich moze korzystaé z innego portu.

Rewec Service [1999)

Rys. 2-2 lkona Rexec95 widoczna na pasku zadan

Po uruchomieniu programu w prawym dolnym rogu ekranu na pasku zadan pojawia
sie ikona przedstawiona na Rys. 2-2. Podwdjne przycisniecie klawisza myszy na ikonie
pozwala podgladac log aplikacji, w ktérym mozemy zobaczy¢ kto i co uruchamia na naszym
komputerze.
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Wskazowki:

o Jezeli korzystamy z systemu Windows NT lub Windows 2000 warto w pierwszej fazie
pisania aplikacji skorzystac¢ z programu rexec95. Uruchamiane jednostki bedg pojawiac
sie na ekranie i bedziemy mogli od razu zauwazy¢ ewentualne btedy. Dopiero kiedy
zobaczymy, Ze aplikacja zachowuje sie poprawnie, mozemy zaczgc korzystac z serwisu
rexecstrv.

e Bardzo wygodne jest uruchomienie na jednym komputerze obu serwiséw. Rexecsrv na
porcie 1999 i rexec95 na porcie 2000. Wtedy wpisujgc odpowiedni port we
wta$ciwoSciach jednostki (WDMConsole) mozemy kontrolowac¢ sposéb jej uruchamiania.
W zalezno$ci od potrzeb jedne jednostki mogq sie pojawiac¢ na ekranie, a inne nie.

2.1.2 Uruchomienie WDMQS

Jak juz wiemy z rozdziatu 1.1, gdzie zostata oméwiona budowa systemu, cata
komunikacja odbywa sie za posrednictwem jadra WDMQS. Komponent ten musi zostaé
uruchomiony przed przystapieniem do obliczeh lub symulacji. Nie ma znaczenia, na ktérym
z komputeréw bedzie dziatat WDMQS. Program uruchamiamy z linii polecen lub instalujemy
jako serwis. Uruchamiajgc program mozemy decydowac, na ktérym porcie ma on pracowac.
Domysinie jest to port 2001. Znajomo$¢ adresu ip i portu WDMQS bedzie nam potrzebna
podczas uruchamiania jednostek.

2.2 Definiowanie struktury za pomocq WDM Console

Pierwszym krokiem po uruchomieniu WDMConsole jest zdefiniowanie nazwy
projektu oraz adres WDMQS. Nazwa musi by¢ unikalna. W WDMQS moze by¢
zarejestrowanych kilka projektow. Tak wiec wchodzimy do menu Project->Settings Rys. 2-3.

Project Settings |
Project Mame: IJﬂEDBS1
Dk Queue Server: 1001001001
Part;
|EDD1

Cancel |

Rys. 2-3 Parametry projektu

Kolejny krok to definiowanie jednostek bioragcych udziat w obliczeniach. Nowe
jednostki dodajemy do projektu klawiszem <INSERT>. Kiedy stworzymy odpowiednig liczbe
jednostek musimy okresli¢ ich parametry (Properties Rys. 2-4).
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?_E:' Distributed Machine Console - jacobs1_txt [j[=]
File Edit “iew Unit Project Tool: Help
EI:-'l M| Stop El:rl
ALFA BE| ) Huir GAMA
|| PEEEE
¥ b=
Je
100,100, a3 Rexec
* N
W iewscieen
[E] Properties

Rys. 2-4 Jednostki zdefiniowane w WDMConsole

e Name postuzy nam jako parametr podczas uruchamiania jednostek. Po
uruchomieniu jednostka potaczy sie z WDMQS podajac name i project. W efekcie
QDMQS zwrdci jej UNIT ID.

e Unit ID — liczba catkowita z zakresu <1-254>. UID wykorzystamy w programie
jednostki do identyfikacji wtasciwej sekcji kodu, ktéra ma zosta¢ wykonana.

e Host — to pole wykorzysta WDMConsole do komunikacji z serwisem wywotujgcym
zdalnie program jednostki.

¢ Command line — ten parametr zostanie przekazany do rexecsrv lub rexec95, a
nastepnie serwis podejmie probe uruchomienia wtasciwego programu.

e PORT — port, pod ktérym pracuje rexec95. Serwis moze pracowaé¢ na réznych
portach w zaleznosci od komputera.

e User name i Password — dodatkowo dostep to rexec95 lub sexecsrv moze byé
zabezpieczony hastem.

W celu podania parametréw jednostki przyciskamy prawy klawisz myszy na ikonie
jednostki i wybieramy Properties Rys. 2-4. To samo mozemy o0siggngé zaznaczajac
jednostke i wybierajgc Properties z menu Unit. Kolejne kroki definiowania parametrow
jednostki przedstawione sg na rysunkach ponizej (Rys. 2-5, Rys. 2-6).
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&} GAMMA Properties HE

e Unit |? Flemu:utel Wl .-’-'-.dvanu:edl

- Mame: IM
LIy

LIt 10 103

(] I Cancel

Help

Rys. 2-5 Parametry podstawowe jednostki GAMMA

Eﬂ GAMMA Properties EHE |

=i Unit 4 FRemate |ﬂ"§ .ﬁ.dvancedl

% Huozt: I'-.-'enus

Cammand Line:

I'x'xl:u:ul:umu:ul:-ile'xunits'xu.e:-:e

(] I Carcel

Help

Rys. 2-6 Parametry zdalnego uruchomienia jednostki GAMMA

Jezeli mamy juz zdefiniowany projekt nalezy zarejestrowa¢ go w WDMQS i mozemy
teraz przystgpi¢ do obliczen. Jednostki uruchamiamy recznie na dowolnym komputerze

podajac jako parametry dane WDMQS i projektu np.:
unit.exe bobmobile 2001 JACOBS1 BETA

2.3 Zdalne uruchomienie jednostki za pomocq WDM Console

WDMConsole potrafi komunikowac sie z serwisami rexec95 i rexecsrv. Za jego
pomocg mozna uruchomié¢ dowolny program na odlegtym komputerze pod warunkiem, ze
jest tam uprzednio zainstalowany serwis rexec i znamy jego parametry (port, username,
password). Sprawdzimy teraz, jak dziata zdalne uruchamianie. Sprébujemy uruchomié¢ na
odlegtej maszynie program kalkulator graficzny calc.exe. Jednak, aby program pokazat sie
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na ekranie, musi tam pracowac rexecsrv na koncie System Account lub rexec95. Jezeli
rexecsrv pracuje na innym koncie, calc.exe pojawi sie jako proces pracujacy w tle bez
dostepu do konsoli. Tak wiec z menu Tools wybieramy Rexec i podajemy nazwe lub adres ip
komputera, na ktérym chcemy uruchomié program. W polu command line wpisujemy
calc.exe i wciskamy klawisz OK. Na odlegtym komputerze powinien pojawi¢ sie kalkulator.
Tak uruchomiony proces mozemy réwniez zdalnie zabi¢: Tools-> Kill. Kalkulator powinien
znikngé. W ten sposodb sprawdziliSmy dziatanie zdalnego uruchamiania.

Mozemy przystapi¢ do uruchamiania naszych jednostek. W tym miejscu zaktadamy,
Ze mamy juz napisany program jednostki. Szczego6towe instrukcje jak napisaé taki program
znajdujg sie w dalszej czesci tego rozdziatu. Aby uruchomié jednostke zaznaczamy jej ikone
i weciskamy prawy klawisz myszy. Z menu wybieramy opcje run. Rys. 2-7 przedstawia kilka
efektow takiego wywotania. W przypadku ktopotéw z uruchomieniem pomocny moze by¢
dodatkowy log (menu View->TraceWindow).

£E Distributed Machine Conzole - jacobs1_txt
File Edit “iew Unit Project Toolz Help
& =3 =E3
g =
BETA GAMMA # @ Stop
i Bun
Il Pauze
el
JACORST
100100100111 2001 & Berec
Kl
Bl view screen
Bi Eroperties

Rys. 2-7 Zdalne uruchamianie jednostek

Oto jak nalezy interpretowac stan jednostek:

e ALFA - jednostka zostata uruchomiona, skomunikowata sie z WDMQS i wywotata
funkcje wdm_barrier.

e BETA - préba remote execute powiodta sie (proces zostat uruchomiony). Jednak
jednostka nie skomunikowata sie w czasie 5s z WDMQS. Najczesciej powodem
takiego zachowania jest wpisanie w projekcie nazwy komputera, na ktérym pracuje
WDMQS zamiast jego adresu IP. Jezeli nazwa nie jest wia$ciwie rozpoznawana
przez komputer, na ktéorym uruchomiona zostata jednostka, nie moze sie ona
skomunikowa¢ z WDMQS (np. localhost, albo nazwa, ktora jest tylko w naszym pliku
hosts). Inna przyczyna to btgd w programie jednostki, ktéra z jakiego$ powodu nie
wywotata funkcji wdm_Unit_Register();

e GAMMA - préba rexemote execute nie powiodta sie. View -> Trace Window zawiera
dodatkowe informacje. Przyczyna: na odlegtym komputerze nie ma serwisu rexec,
niewtasciwy jest port albo hasto. Jednak najczesciej rexecsrv nie moze uruchomi¢
programu, ktéry podaliSmy we wiasciwosciach jednostki w polu w command line.
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2.4 Biblioteka WDM i jej wykorzystanie w przyktadowych
programach jednostki

Program  jednostki piszemy w C/C++ i kompilulemy kompilatorem
Microsoft Visual C++ 6.0. Funkcje biblioteczne zadeklarowane sg w pliku ulib.h, a podczas
konsolidacji nalezy dotaczyé ulib.lib oraz wsock32.lib. Omawiajgc poszczegdlne funkcje
biblioteki zaprezentujemy ich przykltadowe wykorzystanie. Ogélna struktura programu
jednostki wyglgda najczesciej nastepujaco:

{

//Rejestracja w WDMQS
UID = wdm UnitRegister(..)

//odebranie danych od jednostki typu master
wdm_recv (..) ;
//wykonanie kodu jednostki

//wlasciwa sekcja jest identyfikowana na podstawie UID

//przeslanie wynikow do jednostki typu master
wdm_send (...) ;

//powiadomienie WDMQS o zakonczeniu obliczen
wdm_UnitStop ()

}

Program moze byé wspdlny dla wszystkich jednostek (podejscie SPMD). Podczas
rejestracji w WDMQS jednostka dowiaduje sie jaki jest jej identyfikator UID (jakg cze$¢é kodu
ma wykonac lub z jakimi danymi). Jednak najczesciej piszemy program jednostek i program
jednostki typu MASTER. Zadaniem jednostki master jest rozdysponowanie danych i
odebranie wynikéw od jednostek typu slave. Jest to wiec model klient-serwer, gdzie
serwerem jest jednostka obliczeniowa (slave) a klientem jednostka master.

2.4.1 Funkcje rejestrujace

WORD wdm_UnitRegister (int argc, char **argv)

Zadaniem funkcji jest zarejestrowanie jednostki obliczeniowej w WDMQS (Windows
Distributed Machine Queue Server) — module komunikacyjnym. Informacje o WDMQS
jednostka otrzymuje jako argumenty wywotania programu.

W przypadku, gdy jednostka zostata uruchomiona recznie, serwer nic 0 niej nie wie.
Jezeli jest ona uruchamiana za pomocg serwisu rexecsrv, to i tak nie mozna przewidzie¢
jaki port otrzyma. Jednostka nie moze mieé z gory przyznanego portu, bo wtedy nie
uruchomilibySmy kilku na jednym komputerze. Z tych powodéw, to jednostka musi
zainicjowa¢ komunikacje z WDMQS. Od momentu rejestracji serwer bedzie wiedziat gdzie
jest i jak sie z nig komunikowaé. Parametry serwera i projektu to jedyny sposéb, aby
powiadomi¢ jednostke, gdzie znajduje sie WDMQS i jakg funkcje ma petnic. Jezeli jednostka
jest uruchamiana za pomocg konsoli (WDMConsole) wtasciwe argumenty (ip, port, project,
name) sg przekazane automatycznie. W przypadku recznego uruchamiania, parametry
musimy podaé¢ sami. Funkcja wdm_UnitRegister() zwraca identyfikator jednostki w
WDMQS. Po wykonaniu tej funkcji na ekranie konsoli powinna pojawi¢ sie ikona:
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=4
- jednostka aktywna (wywofano wdm_UnitRegister)

Taka ikona moze pojawi¢ sie tylko na chwile, gdyz jednostka zaraz przejdzie do
wykonania kolejnych instrukcji typu: wdm_recv() lub wdm_barrier().

void wdm_UnitStop ()

Po zakonczeniu obliczen jednostka powinna jako ostatnig funkcje wywotaé
wdm_UnitStop(). W ten sposob jednostka powiadamia WDMQS o zakonhczeniu pracy i
pozostaje w tym stanie oczekujgc na sygnat “bye” z konsoli. Stan ten symbolizuje ikona:

=2
- jednostka zakonczyta obliczenia (wdm_UnitStop)

A oto przyktad programu:

//samplel.cpp
#include “ulib.h”
#define ALFA 101
#define BETA 102
#define GAMMA 103
void main(int argc, char **argv)
{
int UID;
int x,vy,2z;
UID = wdm UnitRegister (argc, argv);
switch (UID)
{
case ALFA: // kod jednostki ALFA
X = 10;
break;
case BETA: // kod jednostki BETA
y = 100;
break;
case GAMMA: // kod jednostki GAMMA
z = 110;
break;

}

wdm_UnitStop() ;

}

2.4.2 Funkcje komunikacyjne

Przyktad z poprzedniego rozdziatu (samplel.cpp) pokazuje jak jednostka rozpoznaje,
ktérg czes¢ kodu ma wykonaé. To juz pozwala napisa¢ taki program, ktéry bedziemy mogli
wykonac¢ na kilku komputerach. Jednak kluczowg kwestig w tej pracy jest komunikacja
miedzy rozproszonymi jednostkami.

Przesytanie danych i synchronizacje zapewnia zestaw funkcji podany ponizej:
int wdm recv(int src , char *ptr);
int wdm recv_any (WORD *rsrc, char *ptr);

int wdm _async_recv(int src , char *ptr);
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int wdm_async_recv_any (WORD *rsrc, char *ptr);
int wdm _send(int dst , char *ptr, int len);

int wdm_send over (int dst , char *ptr, int len);
int wdm broadcast (char *ptr, int len);

int wdm broadcast_ over (char *ptr, int len);
void wdm_barrier (int nUID, char *name, ...);

void wdm barrier all (char *name) ;

W pierwszej czesci zostang przedstawione trzy podstawowe funkcje wdm_barrier(),
wdm_recv() i wdm_send(), ktére pozwalajg na synchronizacje i wymiane danych miedzy
jednostkami oraz przyktad programu z wykorzystaniem tych funkcji. Dopiero pdzniej zostang
oméwione pozostate funkcje z tej sekgji.

int wdm_recv(int src , char *ptr)

src identyfikator nadawcy
ptr wskazanie na bufor z danymi

Funkcja zwraca ilo§¢ otrzymanych bajtow. Jednostka wywotuje wdm_recv(ALFA,
&x) kiedy chce odebra¢ dane z jednostki ALFA. Jest to funkcja blokujgca. Taki stan
jednostki jest reprezentowany w WDMConsole przez odpowiednig ikone. Nastepna
instrukcja zostanie wykonana dopiero po odebraniu zadanego pakietu. Funkcja
wdm_recv() pozwala w prosty sposdb na synchronizacje jednostek (ten mechanizm zostat
oméwiony w rozdziale 1.2.1 Synchronizacja procesow).

=4
- jednostka oczekuje blokujgco na dane od innej jednostki (wdm_recv)

int wdm_send(int dst, char *ptr, int len)

dst identyfikator odbiorcy
ptr wskazanie na bufor z danymi
len rozmiar danych

Funkcja wdm_send stuzy do wysytania danych. Dane sg wysytane natychmiast i
trafiajg do bufora wejsciowego jednostki dst. Bedg tam czekaty do momentu, az jednostka
dst zgtosi na nie zapotrzebowanie wywotujagc wdm_recv. wdm_send() zwraca ilos¢
wystanych bajtéw.

void wdm_barrier(int nUID, char *name, ...)

nUID liczba jednostek niezbednych do pokonania bariery
name nazwa bariery
identyfikatory jednostek

Funkcja wdm_barrier stuzy do synchronizacji proceséw jednostek. Znajduje ona
swoje zastosowanie zwtaszcza podczas obliczeh synchronicznych. Parametr nUID okre$la
liczbe zablokowanych jednostek. Parametr name okresla nazwe bariery. Nastepnie nalezy
wymieni¢ nUID identyfikatorow jednostek. Rozwazajgc program samplel.cpp zauwazamy,
ze kod jednostek nie zawiera zadnych mechanizmdéw synchronizacji. Moze sie zatem
zdarzy¢, ze kod jednostki ALFA wykona sie do konca, jeszcze zanim zostang uruchomione

23



2 Instalacja i tworzenie rozproszonych aplikacji przy pomocy systemu i biblioteki WDM

kolejne jednostki. Wykorzystujac funkcje wdm_barrier w naszym przykfadzie kod funkcji
main() wygladatby tak jak w programie sample2.cpp.

// sample2.cpp

void main(int argc, char **argv)
{

int UID;

int x,v,z;

UID = wdm UnitRegister (argc, argv);
switch (UID)

{

}

wdm_barrier (3, “STOP”, ALFA, BETA, GAMMA) ;
wdm_UnitStop() ;

}

Po uruchomieniu wszystkie jednostki skomunikujg sie z WDMQS, a nastepnie,
wywotujg funkcje wdm_barrier. Kazda jednostka bedzie trwata w tym stanie do momentu,
kiedy WDMQS stwierdzi, ze wszystkie jednostki wymienione w wywotaniu funkcji osiagnety
bariere, ktéra identyfikowana jest przez nazwe (“START”). Wtedy WDMQS powiadomi
jednostki, a nasz program (programy) przejdzie do kolejnych instrukcji. Przebywanie
jednostki w stanie ,barrier” jest obrazowane na konsoli w postaci ikony:

=
- jednostka wywotata funkcje wdm_barier()

Sample3.cpp jest przyktadem aplikacji rozproszonej wykorzystujacej poznane do tej
pory funkcje i mechanizmy. Aplikacja sktada sie z 3 jednostek ALFA, BETA, GAMMA.
Jednostki ALFA i BETA majg za zadanie obliczy¢ wartosci x oraz y i nastepnie przestac je
do jednostki GAMMA. Jednostka GAMMA wykona z kolei operacje dodawania i wyswietli
wyniki na ekranie. Tak moze wyglada¢ nasza pierwsza aplikacja rozproszona pracujgca z
systemem Windows Distributed Machine.

//sample3.cpp

//prosty przyklad uzycia funkcji wdm send i wdm recv
#include “ulib.h”

#define ALFA 101

#define BETA 102

#define GAMMA 103

void main(int argc, char **argv)

{

int UID;

int x,vy,2z;
UID = wdm UnitRegister (argc, argv);

switch (UID)
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{

case ALFA: // kod jednostki ALFA
x = 10;
wdm_barrier(B, “DANE”, ALFA, BETA, GAMMA) ;
wdm_send (GAMMA, &x, sizeof (x));
break;
case BETA: /* kod jednostki BETA
y = 100;
wdm_barrier(B, “DANE”, ALFA, BETA, GAMMA) ;
wdm_send (GAMMA, &y, sizeof(y));
break;
case GAMMA: // kod jednostki GAMMA
wdm_barrier(B, “DANE”, ALFA, BETA, GAMMA) ;
wdm_recv (ALFA, &X);
wdm_recv (BETA, &y);
Z =X+ Y;
printf (*z = %d\n”,z);
break;

}

wdm_UnitStop () ;

int wdm_recv_any(WORD *rsrc, char *ptr);

rsrc  w tej zmiennej zostanie umieszczony identyfikator z nadawcy
ptr wskazanie na bufor, w ktorym zostang umieszczone dane

Funkcja ta pozwala odebra¢ dane od dowolnej jednostki. Pakiety sg kolejkowane
przez WDMQS. Funkcja zwraca liczbe otrzymanych bajtéw. Po odebraniu danych rsrc
zawiera identyfikator jednostki, ktéra nadestata dane.

int wdm_async_recv(int src , char *ptr);

src identyfikator nadawcy
ptr wskazanie na bufor z danymi

Funkcja sprawdza, czy w jej buforze wejSciowym sg jaki$ dane od jednostki src.
Jezeli tak, to odbiera pierwszy pakiet i zwraca ilo§¢ otrzymanych bajtéw, w przeciwnym
razie, zwraca wartosé 0.

int wdm_async_recv_any(WORD *rsrc, char *ptr);

rsrc  w tej zmiennej zostanie umieszczony identyfikator z nadawcy
ptr wskazanie na bufor w ktéorym zostang umieszczone dane
Funkcja wdm_async_recv_any analogicznie do wdm_async_recv, jednak nie ma
znaczenia, kto jest nadawcg pakietu. Po wywotaniu, zwraca ilo$¢ otrzymanych bajtéw lub 0.
Obie funkcje wdm_async_recv i wdm_async_recv_any dziatajg podobnie jak juz
omowione wdm_recv i wdm_recv_any z tg réznica, ze nie powodujg blokowania jednostki.
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Jezeli nie ma zadnych danych w jej buforze wejSciowym, funkcja zwraca O i program
przechodzi do wykonania kolejnych instrukciji.

int wdm_broadcast(char *ptr, int len);

len rozmiar danych
ptr wskazanie na bufor, w ktérym znajdujg sie dane

Funkcja zwraca ilos¢ wystanych bajtow. Uzycie wdm_broadcast() pozwala
jednoczes$nie wysta¢ dane do wszystkich jednostek. Dane nie sg wysytane do jednostki,
ktéra wywotata funkcje.

int wdm_send_over(int dst, char *ptr, int len);

int wdm_broadcast_over(char *ptr, int len);

Funkcje wdm_send over i wdm_broadcast over dziatajg analogicznie do
poznanych juz wdm_send i wdm_broadcast. Réznica polega na tym, ze pakiet wystany za
pomocy takiej funkcji trafiajgc do bufora wejsciowego odbiorcy zastepuje ostatnio wystany
pakiet. Funkcja ta znajduje swoje zastosowanie w przypadku obliczen asynchronicznych.
Wolniejsza jednostka nie jest w stanie konsumowaé wszystkich nadsytanych danych, a
interesuja jq tylko najnowsze dane. Dzieki tej funkcji szybsze jednostki nie muszg czekaé na
wolniejsze i jednocze$nie wysylane przez nie dane nie powodujg przepetnienia buforéw
wejsciowych jednostek wolniejszych. Wolniejsze jednostki majg zawsze aktualne dane.

void wdm_barrier_all(char *name);

Jest to odmiana wdm_barier() Stosujemy jg wtedy, gdy bariere muszg pokonac
wszystkie jednostki i nie chcemy ich wymieniac

2.4.3 Funkcje wejscia, wyjscia

Sg to bardzo uzyteczne i niespotykane w innych systemach tego typu funkcje.
Realizujg te same funkcje co ich odpowiedniki w jezyku C, a w tle komunikujg sie z jadrem
WDMQS.

void wdm printf (char *fmt, ...);

void wdm_ scanf (char *s);

Funkcje wejscia, wyjScia pozwalajg na interaktywng prace z odlegtymi jednostkami.
Dzieki nim mozemy obserwowac wyniki posrednie obliczeh bedac fizycznie przy konsoli oraz
wprowadzac¢ dane, o ktére prosza jednostki. Funkcji tych nie nalezy naduzywaé, gdyz mogg
generowac duzy ruch w sieci.

void wdm_scanf(char *s);
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Funkcja wdm_scanf() pozwala operatorowi konsoli na podanie z klawiatury danych,
o ktére prosi jednostka na odlegtym komputerze. Dane mozna wprowadzaé w obu miejscach
tzn. na konsoli i na komputerze, na ktérym pracuje jednostka.

- jednostka oczekuje na wprowadzenie danych (wdm_scanf)

void wdm_printf(char *fmt, ...);

Jest to odpowiednik funkcji printf() w jezyku C. wdm_printf() drukuje wyniki na
swoim ekranie i przesyta je do konsoli.

Program sample4.cpp przedstawia jak za pomocg funkcji wdm_printf() mozliwa jest
prezentacja wynikéw posrednich, na ekranie WDMConsole.

C'D:' Distributed Machine Console - jacobs1 _txt
File Edit Wiew Unit Project Toolz Help

ElALFA

Rys. 2-8 Wyniki dzialania programu sample4.cpp

//sample4.cpp

// prosty przyklad uzycia funkcji wdm send i wdm recv
// oraz wdm printf

#include “..\ulib\ulib.h”

#define ALFA 101

#define BETA 102

#define GAMMA 103

void main(int argc, char **argv)

{
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int UID;

int x,v,z;

UID = wdm UnitRegister (argc, argv);
wdm_printf (“Unit %$03d started\n”, UID);
wdm_barrier(3, “START”, ALFA, BETA, GAMMA) ;
switch (UID)
{
case ALFA: // kod jednostki ALFA
x = 10;
wdm_send (GAMMA, (char *) &x, sizeof (x));
wdm_printf (“*x = %$03d sent to GAMMA\n”, x);
break;
case BETA: // kod jednostki BETA
y = 100;
wdm_send (GAMMA, (char *) &y, sizeof(y));
wdm_printf (“y = %$03d sent to GAMMA\n”, y);
break;
case GAMMA: // kod jednostki BETA
wdm_recv (ALFA, (char *) &x);
wdm_recv (BETA, (char *) &y);
Z = X + VY;
wdm_printf (“f(x=%03d, y=%03d) = %03d \n”, x, y, 2z);
break;
}
wdm_printf (“*** THE END *x%\n") ;
wdm_UnitStop() ;

return;

Po uruchomieniu wszystkie jednostki synchronizujg sie za pomocg bariery
wdm_barrier(). Nastepnie kazda z nich wykonuje swojg cze$¢ obliczen. Identyfikator UID
zostat im przydzielony podczas rejestracji w WDMQS. Jednostki ALFA i BETA wysylaja
dane przy pomocy funkcji wdm_send() do jednostki GAMMA. Dane odbierane sg za
pomocy funkcji wdm_recv(). Wszystkie jednostki wypisujg na ekranie swoje wyniki za
pomocyg funkcji wdm_printf(). Uzycie tej funkcji powoduje przestanie informacji, ktéra
pojawia sie na ekranie jednostki do WDMQS, a nastepnie do WDMConsole. Na Rys. 2-8
widzimy, ze zawarto$¢ ekranu jednostek mozemy obserwowaé, korzystajac z graficznego
interfejsu WDMConsole.

Na zakohczenie przyktad programu realizujgcego obliczenia w sposéb
asynchroniczny (sample5.cpp).

// sample5.cpp Obliczenia asynchroniczne
#include “..\ulib\ulib.h”

#define ALFA 101

#define BETA 102

#define GAMMA 103

void main(int argc, char **argv)

{

int UID;
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int x=0,y=0,2z=0;
UID = wdm UnitRegister (argc, argv);

wdm_printf (“=====BARIERA=====\n");
wdm_barrier(3, “START”, ALFA, BETA, GAMMA) ;
int i=20;

do

switch (UID)

{

case ALFA:
X++;
wdm_printf (“*sending x=%3d to GAMMA\n”,x);
wdm_send over (GAMMA, (char *)&x, sizeof(x));
break;

case BETA:
V++;
wdm_printf (“*sending y=%3d to GAMMA\n”,y);
wdm_send_over (GAMMA, (char *)&y, sizeof(y));
break;

case GAMMA:
wdm_async_recv (ALFA, (char *) &x);
wdm_async_recv (BETA, (char *) &y);
Z =X + Y;
wdm_printf (™ f(x=%3d,y=%3d) = %$3d\n”,x,y,z);
break;

}

while (i-->0);
wdm_UnitStop() ;

Kazda z jednostek zostata uruchomiona na innym komputerze (Pentium 133Mhz,
Pentium MMX 230Mhz, Pentium Il 333Mhz). W petli wykonywane sg kolejne iteracje.
Jednostki ALFA i BETA wysytajg swoje wyniki do jednostki GAMMA przy pomocy funkcji
wdm_send_over. Jezeli w buforze wejsciowym jednostki GAMMA znajduje sie pakiet od
jednostki ALFA, ktéry nie zostat jeszcze odebrany nowy pakiet zastepuje jego miejsce. Tym
sposobem nieaktualny juz pakiet jest tracony. Jak widaé¢ na Rys. 2-9 pakiety od jednostki
ALFA s3g generowane tak szybko, ze GAMMA nie nadaza z ich konsumowaniem. Nie
zdazyta odebrac pakietéw 3, 6, 9, 12, 15, 18. Widac¢ tez, ze jednostka ALFA jako pierwsza
zakonczyta obliczenia.
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EE Distributed Machine Conzole - async. txt
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Rys. 2-9 Rezultat dziatlania programu sample5.cpp

2.4.4 Funkcje dodatkowe

int wdm_kill (char *host, WORD port,
DWORD PID, char *username, char *password) ;
int wdm_rexec (char *host, WORD port,
char *cmdline, char *username, char *password) ;
void wdm_ ParseArgs (int argc, char **argv, char *ip,
WORD *port, char *project, char *name) ;

int wdm_rexec(char *host, WORD port, char *cmdline, char *username,
char *password);

Funkcja wdm_rexec stuzy do komunikacji z Remote Execute Service i uruchamiania
proceséw na innych maszynach. Funkcja zwraca deskryptor utworzonego procesu PID lub
zero w przypadku niepowodzenia.

int wdm_Kill(char *host, WORD port, DWORD PID, char *username, char
*password);

Deskryptor procesu otrzymany w wyniku wywotfania wdm_rexec mozemy pozniej
wykorzysta¢ do zabicia procesu. Do tego celu stuzy funkcja wdm_Kkill.

Za pomocg funkcji wdm_Kill i wdm_rexec programista moze sam z wnetrza
swojego programu wywotywaé programy na innych komputerach. Funkcje komunikujg sie z
pracujgcymi tam serwisami rexec95 i rexecsrv przekazujac im zlecenia.
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void wdm_ParseArgs(int argc, char **argv, char *host, WORD *port, char
*project, char *name);

Funkcja zwraca host, port, project oraz name, ktére zostaly przekazane jako
argumenty wywotania programu. Programista moze je wykorzysta¢ do wtasnych potrzeb.
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